Settings and Features to Consider (1/16/2012)
In other handouts, (past or future) I will deal with a number of applications where the internal settings affect how something operates. This write up provides a summary of many items in several areas that can lead to better performance.  Although some of these reflect my opinion, I have done a lot of web searching to substantiate the position I am presenting.  Modern computers are very complex and sometimes the default settings that come from the factory are not totally suited for smooth, efficient operation.
Also, this write-up started out to be all about changing and improving settings, it has expanded to include some Windows Features that can be very useful.
Internet Explorer (IE)
If you use IE to explore the Internet, there are a few things that can improve the appearance and speed of your surfing.  First of all, in IE 7 and IE 8 the Menu Bar is not on by default.  To turn it on, point anywhere in the top part of IE, RIGHT click and then check the line that says Menu Bar.   This can also be achieved by finding the word Tools over at the right, clicking the down arrow and choosing the Menu Bar entry.
In the Tools Menu, have a look at the Pop-Up Blocker and Phishing filter entries.  I, personally, turn off IE’s Pop-Up blocker because the Google Toolbar (and other applications) also has a built-in blocker.  I also turn off the Phishing Filter because this slows down your browsing.  Another item to look at on the Tools Menu is the Manage Add-Ons entry.  I would disable anything labeled as a “Browser Helper Object” or BHO in the Type column.  Sometimes you will find six or eight of these.  Contrary to intuition, disabling them will speed your browsing.  
Under Tools, Internet Options, General tab you can set your home page.  Also, under Delete, you should periodically get rid of the Temporary Internet Files and Browsing History.  Do not delete the cookies here, because this gets rid of the both the “good” cookies and bad ones.  Use another program such as Spybot S&D or AVG version 9.0, to clean the cookies.  Even though AVG finds many cookies, Spybot is good to have too.  Only one virus checker should be loaded, but you can load all the cookie cleanup programs you want.
Also under Internet Options there are six other tabs besides General.  The default setting for Security is Medium-High.  I would consider lowering it to Medium.  Under Privacy, click on Advanced and check the box that says Override Automatic Cookie Handling.  Some websites actually won’t work unless you let their cookie in.  This makes for smoother navigating, but also makes it important that you run the selective cookie eradicating software periodically.  Blocking third party cookies sounds like a good idea, but it slows you down.
Outlook Express - Windows Mail in Vista – Windows Live Mail in Win 7 (Email Handling)
Many people use Outlook Express (OE) to process their email.  Several settings are critical to good performance.  Under Tools, Options, Security, make sure that the boxes are NOT checked next to “Do not allow attachments….” and “Block images and other….”  Now you will be able to see internal images in emails and view attachments that are sent to you.   For convenience, under General, I would check the box that says go directly to Inbox.  This saves a click when opening OE.  Lastly, you can manipulate the view or the way OE is presented by choosing View, Layout and then checking the boxes of what you would like to see.  
If the people to whom you send email complain that pictures that you attached are not coming though, you need to look at Tools, Options, Send, and then look at HTML Settings for email and be sure there IS a checkmark in front of the line that says, “Send pictures with messages”.

Remember to purge emails out of the Inbox and the Deleted Items folders.  Both have an upper size limit.  Although it is fairly large, if you reach it a number of things will stop working properly. 

Control Panel

The Windows Control Panel is the giant nerve center of your computer.  There are a number of settings here that can have significant impact on the operation of your machine.  First I would change the way the Control Panel is displayed.  By default it is in Category View.  Personally, I find it more user-friendly in Classic View (Win XP and Vista) or in Large Icons View (Win 7).  Below are some of the categories and what they do.  They are not in alphabetical order since the description can be different in XP, Vista and Win 7.  
Display (Personalize in Vista and Win 7) - This is where you can change (or personalize) your background (wallpaper).  This is also where you can decide on a screen saver and the timing of that screen saver.  Most importantly this is where you can change the resolution setting that determines how big items appear on the screen.  A good middle-of-the-road setting is 1024 by 768 if you have a regular monitor or 1280 by 800 if you have a wide screen.   Lower numbers in the resolution setting show pictures and fonts larger.  Higher numbers yield a “finer grid” so things will appear smaller.
You can put your favorite digital picture, or scanned image, as a desktop background.  The easiest way to do this is to open the picture, right click it and choose “Set as Desktop Background” from the menu.
Add/Remove Programs (Programs and Features in Vista and Win 7) - This gives a list of all programs that are properly installed your computer.  This is also where you go to correctly Uninstall them.  Uninstall is different from delete in that all references to a program or update are taken out – including desktop icons.  

Default Programs (Folder Options in Win XP) First let’s talk about file types.  Most files have a three or four character extension.  Examples follow:

.exe is an executable file or program.  Sometimes referred to as an Application. Makes something happen.
.doc is a Word document (.docx in Word 2007 and 2010)
.xls is an Excel file (.xlsx in Excel 2007 and 2010)
.jpg (.jpeg) is a digital picture.  Stands for Joint Photographic Experts Group (That’s today’s trivia)
.pdf stand for Portable Document Format is read by Adobe Acrobat reader.  (often used for forms)

.bmp is a bit map – another format for digital picture.
.txt is a text file

There is a list in your computer that associates a file type with a program.  This association is the default program that opens the file or tried to open it.  There are a number of programs that can open and process pictures.  You can use this default list to make the connection between pictures and the program you are comfortable using.  Also if you do not have MS Word and you don’t want to buy it, you can make the connection between a Word file type (.doc or .docx) and another program such a Microsoft Works or Open Office.  

Security Center (not there in Win 7) - This is where you can determine how Windows Updates are handled and find out exactly what Virus Checker your computer “thinks” it is running.  Remember, you can have only one virus checker.  If a virus checker gets corrupted, it should be removed with the Add and Remove Programs option in the Control Panel (Programs and Features icon in Vista).  If a program won’t Uninstall properly, search the web for a “removal too” that will usually do the job.  I never go anywhere without my Norton Removal Tool.
Windows Firewall - Turn off if you have a router in your house (a router provides a hardware firewall).  Leave on when no router is present.  Since Windows has a firewall, there is no need for another one from an outside vendor.  Too many firewalls can spell trouble.  Commercial virus checkers, such as Norton, include a firewall.  
Power Options - More important for laptops than for desktops.  This is where you go to determine when your monitor actually goes black and your disk stops spinning.  Shorter times should be used with a laptop running on the battery in order to preserve battery power.

User Accounts - This is where you can change the spelling of the user names or make them more personalized.  The picture that is associated with the name can be changed here.  In Vista, it is here, under User Accounts that you can choose to TURN OFF User Account Control (UAC).  In User Accounts, choose User Account Control and then take the checkmark away from the appropriate line.  This will cause the insidious, annoying, paranoid warning message to stop coming up.  In my opinion, these warnings become so irritating that they become useless.  You will be willing to agree to anything you are warned about.  Even though Windows recommends that you leave it on, many people are happier with it off.  In Windows 7, User Account Control is a variable slider.  Move it to the lowest level.
   It is also under User Accounts where you can add or remove a password, change your name or change the picture that appears next to your name.

Mouse – This is where you can change the way your mouse behaves.  It is also here that you can alter the symbols that the pointer uses.  An arrow is default.  You can make it a hand or a seashell or a dinosaur or any number of other pictures.  If your mouse moves too swiftly, this is where you slow it down.
Sounds – This is where you can associate computer actions with certain sounds.  When you turn your computer on a musical crescendo is played.  There are many other sounds connected with other computer actions.  You can change these if you like.  They can even be made into custom sounds.
System – This is where the specifications for the computer can be found.  This includes the amount of RAM, the Operating System and other relevant facts.

Printers and Faxes (XP) - Printers (Vista) - Devices and Printers (Win 7) – This is the area where you can check to see which printers your computer recognizes.  It is also where you can add a printer.  If you are having a problem with a printer not working, check here to see if there are any jobs queued up to print.  If you see a printer icon in this section and there is a non-zero number next to it, this indicates that a document is waiting to print.  If that print failed, your printer is out of commission until that job is cleared.  It is sort of like putting a rock in a funnel – nothing gets through until the rock is removed.

Network Setup Wizard (XP) - Network and Sharing Center (Vista and Win 7) – Although setting up a network is beyond the scope of this write-up these are the Control Panel entries where you would make appropriate changes.  Networking several computers in the same household could be a topic for future meetings.

Desktop Gadgets – A neat feature in Win 7 that lets you put things on your desktop such as a calendar, an analog clock, weather forecasts etc.  Double click this icon and do a little playing.

Date and Time – This is where you can change the time zone your computer resides in or adjust the time or date.  If you live in AZ it is important you say Arizona Time Zone instead of Mountain Time Zone.  Arizona does not observe Daylight Saving Time (Hawaii too).  The computer will automatically make that change unless you tell it that you are in an area that doesn’t observe it.  Access to date and time can also be accessed by Right clicking the clock in the lower right hand corner.  (Trivia Fact: all computers, including desktops have a small, 3V battery (about the size of a quarter) in them that permits the computer to remember the date and time even when the machine is turned off.  I’ll bet you’re wondering about how this was done.  This battery typically outlives your machine, but if it does die, you will lose the date and time every time you turn the computer off.  This can create a multitude of problems.)  
Caveat – there are so many setting that can be accessed through the Control Panel, that you must be careful not to change things that you don’t totally understand.  Some strange behavior can result.
Configuration Utility
The boot or startup instructions of your computer are found in the Microsoft Configuration Utility.  You gain access to this in XP by left clicking the Start Button, Clicking Run and then typing MSCONFIG in the Open box that appears.  In Vista, left click Start and type MSCONFIG in the box that shows Start Search in it.  It will write over Start Search.  After you hit Enter a window will appear showing you this utility.  If your computer is new, or never been “tuned up” the Normal Radio Button will be chosen.  This is really not what you want, because when this is chosen, every program that is listed under the Startup Tab will be initiated at boot time.  Change this to Selective Startup and then click the Startup Tab.

Now the fun part.  Everything that is checked in the startup list starts at boot time.  If this list is really long (and it gets bigger the longer you have had your computer), it is advantageous to UNcheck some of these items.  The trick is to know which ones to change.  Remember that unchecking them will not delete or uninstall the item, but rather will just prevent it from starting at boot time - thereby saving you some resources.  There is a website http://www.sysinfo.org/startuplist.php that gives an explanation of just about every item you can come across.  Type the letters from the first column of the utility listing into the box on that website and see what it tells you.  Uncheck things that are not necessary.  After going through the whole list, hit Apply and then Close and restart your computer.  This will make the changes take effect.   You will get a message on restart that says you are using Selective Startup.  Check the box that says “don’t show me this again” and then click OK.   Notice there will likely be fewer items in the System Tray (the string of icons that appear in the lower right hand corner of your screen, next to the clock).  The System Tray reflects many, but not all, things that are running in the background.

Start Menu and Task Bar
It is possible to change the appearance of the Task Bar and Start Menu.  Right click anywhere on the Bar and it will produce a menu.  The most important items on this menu are the first, Toolbars, and the last Properties.  Toolbars give you a fly-out menu that lets you turn several things on/off.  Having the Quick Launch menu on is useful.  It gives you a group of icons in the lower left corner that can always be seen and that can be used to launch an application with a single click.  This list can be changed by dragging icons on and off.  In Win 7 the equivalent of the Quick Launch Menu is achieved by “pinning” icons to the task bar.  

The Properties entry lets you alter the way the start menu looks and also change things that appear in the Start fly-up menu.  It also lets you lock the Bar and/or automatically hide it.  

If you want the task bar at the top or side of the screen, simply point at the bar and click and drag it to where you’d like it to appear.  Occasionally the bar is moved (perhaps by accident).  This click and drag procedure can be used to put it back at the bottom.
Windows Explorer IS Different from Internet Explorer

Get into Windows Explorer by RIGHT clicking the start button and then left clicking Explore.  A keyboard shortcut to going this same thing is to hold down the Windows Key on the keyboard (Has the Windows Logo on it and touching the “E” key – see Keyboard Shortcuts further down this document).  From the menu click Tools, Folder Options, View and make the following changes from the default settings: Change dot to be in front of “Show hidden files and folders” and take the checkmark away from the line that says “Hide extensions for known file types”.  As long as you trust yourself not to carelessly delete files, seeing the hidden files is a good thing.
In Vista, open Windows Explorer as above, but then click on Organize, Folder and Search Options and then the View tab.  
Windows Explorer is a two-paned window.  The left side shows your file hierarchy, while the right side expands whatever is highlighted on the left.  From this screen you can create new folders and move files (documents, pictures, videos) from one place to another to keep them organized.  A click and drag (hold the left mouse button down while pointing to a file and move the mouse to the destination location).  If it is on the same drive (e.g. going from C to C) the file moves.  If it is on a different drive letter (e.g. going from C to backup drive E) the file is copied.  This is a way to backup your files for safekeeping.  For further organization, you can create new folders that have unique names.  Example: a folder named “family reunion” would contain pictures relevant to that event.  Click on New Folder and assign a name.  Then move files, etc.
If you Right click on the C Drive in Windows Explorer and then left click on properties, it will show you a pie graph showing how full your hard drive is (Blue area is occupied).  There is also a button there for Disk Cleanup.  Left click that and let Windows do its thing.  After a short time it will show you files that can be eliminated with no consequence to you.  Doing this periodically is a good thing.
Disk Defragmentation
As the name implies, this is the process of consolidating files that are split on your computer’s main drive or drive C.  A “fragmented” file is like a newspaper article that starts on page one and finishes on page eight.  Defragmentation not only consolidates these types of files, but also “pushes” whole files together to eliminate gaps.  This consolidates most of the free space in one area of the disk.  Visualize your hard drive as a very long bookshelf full of books.  Fragmented books are like multi-volumes that are not contiguous.  Also if you go through and purge some old useless books, throwing them out will leave spaces.  The act of defragmentation puts the multi-volumes together and also slides all the books to one side so all the small gaps become a big empty space.

Fragmented files take longer to access, so a defragmentation can result in faster disk access.  In general, you don’t have to do this process more than once every other month or so.  Another time to do it would be if you delete a lot of files (photos, documents or songs) that create gaps.  Win XP allows you to analyze the disk to see if a defrag is necessary.  Click on Start, All Programs, Systems Tools and the Disk Defragmentation.  In Vista and Win 7 Defrag can be set up to run automatically at set intervals.
System Restore
Beginning with Windows XP, the operating system periodically creates a “Restore Point”.  This is like a snapshot of your computer that you can revert back to if you want.  This is a rather unsophisticated method of undoing something that may be messing up your machine.  If you have strange behavior in your computer that you just can’t resolve, doing a system restore to a previous date, may resolve the issue.  It is found under All Programs, Accessories, System Tools and then System Restore.  In XP it gives you a calendar where restore dates are shown with bold numbers.  In Vista and Win 7 it is a slightly different format, but works the same way.   Several points worth noting: 1) If system restore doesn’t solve your problem you can reverse the process and undo the restore, 2) System restore doesn’t always work – you may get a message that says restore unsuccessful and 3) Documents you have created and email received are NOT affected by system restore.  
Safe Mode
This is not to be used frivolously but can be handy under certain circumstances.  If your machine happens to contract a virus that is fairly debilitating, starting up in Safe Mode can give you access to things that the virus blocks in normal mode.  To get into Safe Mode turn off the machine completely.  Then, upon restart, begin tapping the key marked “F8” repeatedly.  This will interrupt the boot and give you a white on black screen that gives choices on how to startup.  Use the keyboard arrow keys to get you to the entry marked “Safe Mode with Networking” and then hit Enter.  Your machine boots up “half conscience” with Internet capability.  Often diagnostics and cleaning is more effective in this mode.   See Internet or call me for help.
Keyboard Shortcuts 
There are often several ways to do the same thing on a computer.  Some “Mouse-a-phobes” would rather use the keyboard if they can - versus using the mouse.  Here are a few keyboard shortcuts that can be useful.  First find the key marked with the Windows Logo.  This is, coincidently, called the Windows Key.  Holding it down and hitting certain letter keys cause things to happen.

Win – hitting this button alone opens the Windows Menu
Win+E – Opens Windows Explorer

Win+F – Opens the Search (Find) box

Win+M – Minimizes ALL open windows      Win+Shift+M – Reverses the Minimize procedure
Win+R – Opens the Run Box

There are MANY, MANY shortcuts. Trying to list them all is way beyond the scope of this document.  Type “keyboard shortcuts” into Google and you will get extensive lists.  Here are a few more that can be handy.

Ctrl+Alt+Del – called the three fingered salute and opens the task manager

Ctrl+C – Copies highlighted text (C stand for Copy)
Ctrl+X – Cuts highlighted text and puts it on the clipboard (Think of the X as a pair of scissors = Cut)

Ctrl+V – Pastes from the clipboard to location of cursor (Think of the V as standing for Velcro = Paste)

Alt-Tab – permits you to toggle between open windows

F1 – Opens a help file

F3 or Ctrl+F – Opens a window to let you search for text on a given document or page.

F5 – Refreshes the screen.  Especially useful for Internet Pages.
Microsoft Office 
Many settings determine how Word and Excel are displayed by default.  These can go a long way to making Office Applications easy and convenient to use.  The factory settings, in my opinion, are not really user-friendly.  Note: Several talks will be devoted to Word and Excel later this season.
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